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Overview

CaseCAD is a simple CAD (Computer Aided Design) program to help you plan and obtain case inserts

made of high-quality packing foam. You could, of course, cut pockets in foam yourself, perhaps using a

serrated kitchen knife or a single-edged razor blade. CaseCAD offers a more modern tool—your

computer and the Internet—in recognition that packing foam is a notoriously difficult thing to cut.

The trouble most people encounter when they try to cut case foam for themselves explains why factory-

provided foam sets typically come pre-scored, so that the user has merely to pluck out foam squares to

make pockets. While convenient, the resultant pockets rarely match the shape of the equipment they

are supposed to house: Because the openings must conform to a pre-scored grid, curved pockets are

impossible, and even for rectangular items, the fit might be awkwardly tight or awkwardly loose. Worse,

the slab of prescored foam, being physically compromised from the start, tends to fall apart with use.

CaseCAD’s fabrication service sidesteps these problems by offering case owners the opportunity to

specify the shape of pockets precisely using this simple CAD program. Because the case inserts we

provide are laminated from multiple layers of foam, you can specify the depth of each pocket and even

place deeper pockets within shallower ones to accommodate objects of complex shape. CaseCAD will

also add “finger holes” for each pocket automatically. These openings allow you to grab an object easily

and withdraw it from the foam, adding a professional touch to your case insert.

After you design the exact foam insert you need using CaseCAD, you can order it immediately online.

Within a few days, we will ship you a case insert sculpted to your specifications using a computer-

controlled router. Instead of having rough, jagged or ill-fitting cutouts, the interior of your case will

have precisely shaped pockets. So with CaseCAD the inside of your case will function optimally, and it

will look every bit as clean and professional as the equipment it houses.

The operation of CaseCAD is largely intuitive—go ahead and experiment with it now. The tips shown

when you place the cursor over the various buttons provide enough information to get you started.

Types of Cases



If you are configuring a foam insert for one of the more popular PELICAN™ equipment cases, CaseCAD

will size the foam for you. Just choose the appropriate model in the start-up wizard. Need to outfit

another type of equipment case? Just select Custom Case in the start-up wizard and you will be

prompted to specify the length, width and depth of your custom foam insert. That is, you should enter

the interior dimensions of your case. Note also that you should specify that the insert be at least

¼ inch less than the depth of your case to allow for manufacturing tolerances in the thickness of

the foam layers used.

The start-up wizard also gives you options for fitting inserts to cases with canted sides and rounded

corners. And CaseCAD allows you to make whatever side cutouts you need to accommodate locks or

other protrusions. So you will be able to fit the insert exactly to your case.

Foam Properties

Our case inserts are fabricated of a premium-quality packing foam—something usually found only in

high-end, custom-made cases. While flexible, this material is much more resilient than the soft foams

one typically finds inside cases. With soft foams, equipment can easily “bottom out” in a fall, whereas

the type of foam we use is similar to that employed in protective athletic gear, so your equipment will

be much better protected from shocks. This foam (a polyethylene packing foam) does not absorb

moisture when exposed to rain or spills.

Although our foam is of roughly the same color (charcoal gray) and density (2 pounds per cubic foot) as

the type of foam typically seen in hard-sided cases, it is physically much tougher, so it holds up much

better over time. And the foam we have selected has a soft feel, further adding to the quality of your

custom insert.

For customers who elect to have foam for the lid included, the material we use depends on the depth of

the lid. If it is 1” or less, the lid foam will be the same material used for the main section of the insert.

For lids that are deeper than 1”, we normally use a combination of foam types: convolute (“eggcrate”)

urethane foam backed by the more resilient packing foam used in the main section. This provides a

good combination of flexibility and protection. (For more information, see “Manufacturing Specs”

documentation.)

Understanding the Display and its Coordinate

System

CaseCAD represents the foam as a gray rectangle on the screen and sets the origin of the coordinate

system at the upper left corner of this rectangle. This point corresponds to the back left corner of your

case when placed flat on a table in the usual position, with the lid hinges located away from you.

The height of the gray

rectangle shown on the

screen then

corresponds to the

back-to-front

dimension of the foam

insert; the width of

this rectangle

corresponds to the

left-to-right dimension.

White dots are shown

at 1-inch intervals for

reference. The X

measurements



indicated in the status

line at the bottom of

the screen give

distances to the right

of the origin point.

Similarly, the Y

measurements give

distances downward

from the origin. All

measurements are in

inches.

Note that you can temporarily shift the pockets you design in CaseCAD off the foam while you are

working, but you must position all pockets at least 1 inch within the perimeter of the foam before

saving the file and ordering fabrication. (For PELICAN™ cases or other cases with sloping side walls, the

required margin is slightly wider, so as to maintain adequate spacing between the pockets and the

angled walls of the case.) You will be alerted when you try to upload the design if the placement of any

pocket fails this test.

Designing Pockets with CaseCAD

You can use CaseCAD to create an infinite variety of pockets. Many common objects call for a pocket in

the foam that has the shape of a circle, a square, rectangle or a regular polygon. In such instances, all

you need to do is to measure the object with a ruler and to enter the relevant dimensions when

prompted. Some things, however, have rather complicated outlines. For such items, CaseCAD allows

you to design matching pockets of arbitrary shape by specifying the vertex points of an irregular

polygon.

Specifying the Shape

To create a circular pocket, choose Circle from the Add menu and then enter the diameter you desire in

the dialog box that appears.

Note that you can also create circular pockets using

the Circle tool on the left-hand tool bar to draw a

circle with the cursor. You can easily adjust the size of

an existing circle by dragging on one of the red anchor

points shown when you select it, by choosing Display

and Edit Properties from the Pocket menu, by clicking

on the Properties button on the top tool bar or by

simply double clicking on the pocket itself.

Squares and rectangles can be created similarly, with

the Add menu or by dragging after choosing the Rectangle tool on the left-hand tool bar. As with

circles, CaseCAD allows you to display and edit their properties at any time. By default, rectangles are

created with small circular openings cut into the four corners (below, left); these provide a helpful

amount of clearance in case the object that is to be inserted into the pocket has sharp, right-angle

corners. Or you can choose to not to have these openings made, which will result in the corners of the

pocket being rounded to a one-eight (0.125) inch radius (below, right).



You can also use the Add menu to create a regular polygon (a hexagon or an octagon, for example).

This option is useful too for creating oval pockets: just create a regular polygon with a large number is

sides (say, 100), which you can then apply different horizontal or vertical scale factors using the Pocket

menu (Pocket —> Scale…).

You can create a pocket of arbitrary shape by first selecting the Polygon tool on the left-hand tool bar

and then clicking where you want vertices to be located. You close the polygon by clicking on the

starting point or by depressing the space bar.

Selecting the polygon by clicking on its interior shows the location of its defining anchor points, any of

which can be moved by dragging on it or by right clicking on it and entering the desired X-Y position

into the appropriate fields. Right clicking also allows you to delete an anchor point or to insert an

additional anchor point adjacent to the one you’ve chosen. You can drag on any of the anchor points to

change the shape of the pocket or the location of the finger holes associated with it. You can also

display and edit the properties of the pocket, such as the depth or the orientation of finger holes, as

needed.

Polygons can also be

used to make side

cutouts. Why would

you want a side

cutout? Because many

cases require openings

around the perimeter

of inserts to

accommodate locks,

hinges and so forth.

You can easily arrange

such cutouts by first

creating the

appropriate shape with

the Polygon tool. You

must then do two

things. First specify



that the resulting

pocket not have finger

holes (double click on

it and choose No finger

holes). Next, you must

be sure that at least

two of the anchor

points fall on the straight sides of the foam perimeter.

Note that if you selected a PELICAN™ case with wheels from the start-up wizard, cutouts will be made

automatically near the base of the insert to provide proper clearance. The blue rectangles show the

location of these cutouts, which are on the bottom of the insert. Positioning the cursor over these blue

rectangles will indicate how deep a pocket you can place over these bottom cutouts without interfering

with them. You should be mindful of this limitation, because the software will not impose any special

limits on pockets placed near these areas.

Tracing

“But I want to make a rather intricately shaped pocket—how do I know where to click?” CaseCAD can

help you fit complicated shapes—just use the Trace menu. Here you can choose Object on the Screen

and then trace the object directly by holding it against the face of your computer monitor. Even better,

if you have a scanner you can capture a jpg or gif image of the object you want your case to hold and

choose Trace Stored Image from this menu.

You can then click around the perimeter of the object shown in the image to design the pocket. This

makes even complex pockets a snap to create. And you can readily adjust things later (shifting the

location of individual points, adding or deleting points and smoothing the outline of the entire polygon),

allowing you to achieve results of professional quality both quickly and easily.

Finger Holes

Each of the pockets you create, whether a circle, square, rectangle or polygon, will by default have a

pair of finger holes straddling it. These appear as light gray rectangles or squares on the top and

bottom (or left and right) sides of the pocket.



These one-inch-deep

openings allow you to

grab hold of your

equipment without

having to squeeze your

fingers between an

encased object and the

foam. You can change

their shapes by

dragging on the anchor

points that define them

when you have the

pocket selected. And

you can shift them

from the top and

bottom to the left and

right when you display

and edit the properties

of the pocket. You can

also choose to forego

finger holes from any

given pocket, but this

option should be

reserved for special

situations, such as when the pocket is placed within another one or when it is being used to make a

side cutout.

Depth Adjustment

When first created, each pocket will be set for the maximum depth possible. That is, the pocket will be

configured to extend all the way to the fixed-thickness layer of foam that is attached to the base of

your insert. The thickness of this base layer varies, depending on the model PELICAN™ case you are

using or, if you are designing an insert for another type of case, on the specifications you provide when

you first begin the project. You can easily change the depth of any pocket when you invoke the window

to display and edit its properties.



CaseCAD uses different shades of gray to help you keep track of pockets that are of different depths,

with the darkest grays corresponding to the deepest pockets.

You can make rather

complex openings in

the foam by combining

pockets of different

depth. As you will be

able to see from the

display, in areas where

pockets of different

depths overlap, the

deepest pocket takes

precedence. Thus you

can place a deep

pocket within a shallow

one but not vice versa.

If you do place a

pocket within a pocket,

you’ll note that when

you click on it, both

that pocket and the

larger pocket within

which it is located

become selected. To

manipulate the deeper

pocket, simply select

the shallower pocket first and then lock it using the Pocket menu (Pocket—>Lock). This allows you to

select the deeper pocket and adjust its position or properties. To unlock the other pocket, use the Edit

menu (Edit —> Unlock All).

Testing the Fit

Although printing a paper copy of the complete design is rarely necessary, we strongly advise you to

print a copy of each and every pocket you create and test it by cutting the shape from the

paper with a pair of scissors and placing the object you want to encase in the opening. You

can do so by selecting the pocket and then choosing Print Selected Pocket from the File menu. (The

fiducial marks provided allow you to test pockets that are larger than a single sheet of paper: You need

merely to align the fiducial marks and tape the pages together before cutting.) This simple exercise

allows you to evaluate the fit of the pockets you specify before committing to them.

How exactly should an object be fit? The walls of a pocket should just “kiss” the sides of the object it is

supposed to contain, but they do not have to do so everywhere. Indeed, it’s better to leave some

clearance, particularly around any irregular protrusions, than to try to match each and every feature of

an object you want to house. Having the sides of a pocket in light contact with the encased object in

just a few spots is all you really need to prevent it from shifting. Minimizing the area of contact in this

way ensures that you will be able to insert the object and withdraw it without encountering too much

friction. Make sure that the object fully clears your paper cutout and do not rely on the

compressibility of the foam if things look at all tight. Rather, adjust the shape of the pocket and

try it out again. Don’t be surprised if it takes you a few tries to get things perfect; this is normal. The

beauty of using CaseCAD is that you can experiment easily with paper and scissors and get everything

to fit as you want before you order the foam insert to be made.

Spacing Between Pockets

Although the CaseCAD software does not impose a mandatory minimum, you should leave at least 1



inch of foam between pockets (including any finger holes). Allowing less than this not only compromises

protection, but it can also compromise accuracy, because thin walls between pockets will tend to flex

while the foam is being machined. Another reason to space pockets comfortably far apart is that thin

walls of foam between pockets offer very little surface area on the bottom for adhesive, so are also

prone to delaminate. If you choose not to follow our guidelines and place pockets closer

together, you must take responsibility for any unexpected results. The same concern applies if

you create a polygon that folds back on itself or has its finger holes awkwardly placed so as to leave

only a thin wall of foam standing between openings on either side. (We reserve the right to decline

orders for designs with pockets that are, in our view, placed too close together for good results.)

Although it is usually okay to arrange for two or more pockets to overlap so as to create a

more-complex shape, you should use this technique with caution, making sure that you do not isolate

any area on the foam with a “moat” of surrounding pockets or finger holes. That is, you must maintain

continuity of the foam that borders your pockets. So, for example, you should not overlap four thin

rectangles like this:

Submitting such a design would result in an insert with a single square pocket, without any “island” of

foam in its center.

Another reason to use caution when you combine two or more pockets to create a more-complex shape

is that you will use up your standard allotment of pockets more rapidly than if you had constructed the

desired shape using a single polygon. Creating a polygon might take you a few moments more, but it’s

usually well worth the effort, especially because polygons allow you to add or delete individual anchor

points, unlike the other fundamental shapes CaseCAD uses.

Ordering Fabrication

The Order menu allows you to compute the cost of the foam insert you have configured and to upload

your design to us for fabrication. The price you see quoted will depend on the shape and size of your

insert, whether you choose to have new foam made up for the lid of your case and whether the number

of cuts required for the pockets exceeds the standard allowance (which is equal to 24 one-inch-deep

pockets, 12 two-inch-deep pockets, 8 three-inch-deep pockets and so forth.). To learn more about our

fabrication procedures, read the Manufacturing Specs help file (found with this document under the

Help menu). For a full description of our pricing formula, consult www.CaseCAD.com. Please understand



that our prices are subject to change.

Before you upload a design for fabrication, you should of course make sure that the pockets you have

specified are sized and arranged exactly as you want them. As mentioned, you’ll be assured of your

design if you print each pocket, cut out the printed shapes with a pair of scissors and then compare the

openings to the objects you intend to encase in foam. (See Designing Pockets with CaseCAD.)

Note that before uploading you must first save your design, which creates a .ccd file in the directory of

your choosing. Continuing with the order wizard then allows you to upload your design to our servers.

This, of course, requires that your computer is connected to the Internet. Use the software's Order

menu to upload one or more designs. When done uploading, the software will launch your Web

browswer and navigate to a page at CaseCAD's online store from which you can purchase one or more

of your custom designs using secure e-commerce protocols.

Normal turn-around time from receipt of payment over the Internet to shipping of a single insert is six

business days. A good rule of thumb when purchasing multiple inserts is to allow one additional

business day for each additional insert in your order. If we anticipate substantially greater time will be

needed for fabricating the items in your order (say, because of a large backlog or an unexpected

equipment failure) we will alert you and provide our best estimate of the time needed to fabricate your

insert. Once we complete your order, we will send you an email message containing a tracking number

so that you can follow the progress of the shipment.

If you experience any trouble uploading or purchasing the insert you have designed, send a message

describing the difficuly to support@CaseCAD.com so that we can remedy the problem as quickly as

possible.

Details of CaseCAD Operation

The Menu Bar

The File and Edit menus will be familiar to you. The File menu allows you to start a new project, open

an existing one or save one to a file, which will then be given a .ccd (CaseCAD) extension. This menu

also allows you to print individual pockets or a copy of your complete design. Because a typical case will

be larger than a single sheet of letter-sized paper, the printout will contain a series of numbered

crosses, which allow you to align the multiple sheets needed to encompass the project.

The Edit menu allows you to cut, copy and paste shapes and also to delete them. This menu also

provides for undoing the previous operation, selecting all pockets and for unlocking all pockets that had

been locked to prevent changes.

The Add menu lets you add a square, rectangular, circular or (regular) polygonal pocket according to

the dimensions you set in a dialog box. You can then move the pocket anywhere on the foam simply by

dragging on it.

The Pocket menu allows you to perform various operations on the pocket you have selected—that is, on

the one that you have clicked on with the arrow cursor so that its red anchor points are visible. Using

the Pocket menu you can:

Display and manually alter the properties of the selected pocket

Lock the selected pocket so that it cannot be moved or modified accidentally. (Unlocking is

accomplished using the Edit menu.)

Enlarge or shrink the selected pocket uniformly, or (for rectangles, squares and polygons) stretch

and squeeze it in one dimension only



Change the orientation of the finger holes, which are placed on either side of a pocket so as to

allow for easy insertion and removal of equipment. (A feature we strongly recommend using,

except perhaps in a few special circumstances.)

Rotate a polygon by the number of degrees you specify

Smooth the perimeter of a polygon by applying a specified bevel to each vertex point

Flop a polygon, which is useful for situations where you have drawn a polygon by tracing over an

image of the bottom of the object you want to encase in foam

Flopping thus allows something like this:

to be easily converted into something like this:



You can also use the last item on this menu to manipulate multiple pockets—either aligning them or

distributing them evenly in the X or Y direction.

The Trace menu provides the means to fit pockets to even the most complex shapes. Perhaps the

easiest and most accurate method to fashion a pocket for a complicated shape is to trace over a .jpg or

.gif image of the object that you want to encase in foam. For many objects, you can acquire a suitable

image simply by scanning it on a flatbed scanner. Just specify to CaseCAD the resolution of the image

(in dots per inch, dpi) after you open it. As with circles and rectangles, you will want to design your

pocket so that the walls are just “kissing” the object in few places; that way the fit will not be so tight

that it is difficult to get things in and out. So don’t try to match every little feature on the object you

want your case to hold, which is difficult (or impossible) and, in any event, unecessary. Rather, design

your pocket to leave ample room where small protrusions stick out to the side of the object. Having the

sides of the pocket make contact where the perimeter of the object is more regular is a better strategy.

Note that you need not outline the object perfectly when you first trace over its image: you can easily

modify the position and number of anchor points after completing the polygon.

To review, the steps for matching an arbitrary shape are:

1. Scan or otherwise obtain a .jpg or .gif image of the object you want to match. A relatively low

resolution scan (for example, 75 dots per inch) works perfectly well.

2. Use the Trace menu, choosing to trace over a stored image.

3. Use the dialog box presented to you to open the image file.

4. Specify the resolution of the image in dots per inch (dpi) in the dialog box shown to you next.

5. Once your image is displayed, pick a pen color that will stand out and click around the edges of the

object to define the pocket, matching the outside of the line to the shape you want to fit. End by

clicking on your starting point or by pressing the space bar.

6. If necessary shift anchor points by dragging on them until you have them all arranged correctly. As

noted, you need not match every little feature on the object. Indeed, you should make sure that you

leave enough space so that no part of your equipment will tend to hang up on the surrounding foam.



7. Click Make Pocket to add the pocket you have designed to your project.

CaseCAD’s Trace menu also allows you to trace over an object placed against the screen of your

computer. This is more cumbersome that working with an image file, but allows you to skip the

scanning step. Because the height and width of computer displays differ, you first must provide a

calibration by measuring the dimensions of the colored window you see when you invoke this option.

The Configuration menu allows you to select whether you want lid foam included with your insert. This

menu also allows you to modify the overall size and shape of the insert (dimensions, corner rounding

radius, and so forth). You can also use this menu to review the configuration of your design and to look

up its six-letter product code (which is assigned when you upload the design to CaseCAD's online store).

The Order menu allows you to find out the cost of the foam insert you have configured, to upload your

design to us for fabrication.

The Help menu provides access to this document and to a short companion guide describing our

manufacturing specifications.

Tools at the Left

The set of tools shown at the left side of the main window are arranged so that only one tool is in use

at any given time. The choice of tool depends on the action you want to perform.

 This tool is used to select a pocket by clicking anywhere inside it. Once you select a pocket, its

anchor points (red dots) become visible. You can modify the shape of the pocket or the configuration of

the associated finger holes by dragging on one of these anchor points. You can also modify an individual

anchor point (or add an additional anchor point adjacent to an existing one) by right clicking on it.

Double clicking on the interior of a pocket with the selection tool brings up a window that shows the

properties of the selected pocket and allows you to modify them. The selection tool also allows you to

move a pocket by dragging on it. Dragging on an anchor point modifies the shape of the pocket. Note

that after selecting a pocket, you can add to your selection by holding down the shift key or the control

key and clicking on another pocket.

What do I do if I inadvertently create two identical pockets placed one on top of the other? This might

happen, for example, if you copy a shape and paste it into the project, then copy the original shape and

paste it again. Clicking on the pocket then selects both the pocket you see and the one underlying it.

Double clicking will result in an error message telling you that more than one shape has been selected.

The solution is merely to move an anchor point on the perimeter of the pocket. This will change the

shape of the visible pocket, allowing you to see (an manipulate) the one underneath independently.

 This tool is used, naturally enough, to create rectangular pockets. Simply drag the cursor (a cross)

in the main window, which will create a rectangle.

 This tool works similarly. After selecting it, you can create a circular pocket by dragging in the

work window.

 This tool allows you to create a polygon with any number of sides. After selecting this tool, the first

click in the work window will start the polygon and an anchor point will become visible. Subsequent

clicks in the window create the sequence of points that define the polygon. To finish, click on the

original point (where the first anchor is shown) or depress the space bar.

 This tool allows you to zoom into a selected area. Simply drag the cursor across the region of

interest, and the zoom will be adjusted accordingly.



Buttons at the Top

 With a shape selected, clicking on this button shows its properties, which you are then free to

modify.

There are three buttons for changing the zoom:

 This button zooms the view in.

 This button zooms the view out.

 This button sets the zoom out all the way so that all of the foam will be visible in the window.

Contacting Us

We urge you to contact us by email with questions, comments or suggestions about CaseCAD or our

Internet-based fabrication service. Just send a message to support@CaseCAD.com.
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